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Technical Support
If you have difficulties using DrawPad Graphic Design Software please read the applicable 
topic before requesting support. If your problem is not covered in this user guide please view 
the up-to-date DrawPad Graphic Design Software Online Technical Support at 

www.nchsoftware.com/drawpad/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to DrawPad Graphic Design Software, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/drawpad/support.html
www.nch.com.au/suggestions/index.html
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About DrawPad
Introduction 

DrawPad is an easy to use program for drawing and designing images. With DrawPad you 
can easily create vector graphics from your artwork and save in multiple formats. 
DrawPad is designed to be quick and easy, while providing powerful features such as 
non-destructive and layer based editing. 
Supported File Formats 
Open and load variety of image and graphic file formats such as .jpg, .gif, .tiff, .png, .bmp, 
.ico, .pdf, and .svg. 
Save and export your projects to different formats such as .psd, .pdf, .eps, .svg, .jpg, .png, 
.bmp and .ico. 
You can always continue working on your projects by saving it as DrawPad project file 
(.drp). 
System Requirements  
Windows XP / Vista / 7 / 8 / 10 
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Application Search
The Search Dialog can be used to search for various features and tools inside DrawPad. 

Find Effect or Tool  
Type a keyword of tool or effect you want to find. 

Search Button 
Click button to start searching. 

Search Results 
All related items to the search keyword will be displayed here. Sort the columns by clicking 
on the column headers. Click an item to automatically use it and know where to access it. 
● Feature  - Name of tool, effect or option. 
● Location - Feature's location within DrawPad. 
Search More on Help Pages 
Clicking the link will redirect to browser and allow online searching on help pages. 
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.

There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Flickr Authorization
DrawPad can make it easy and convenient to upload your photos or videos to Flickr. However, 
it needs your permission before you use it. 
If you click the Authorize... button, the Flickr website will open in your web browser. If the 
Flickr website shows a login page, please log in. The website will then ask if you want to link 
DrawPad to your Flickr account. Please click OK, I'll authorize it. The website will then show 
a nine digit verification code. Please type or copy and paste the code from the website into 
DrawPad and click Continue. 
Flickr Authorization 
If DrawPad has the authorization of a Flickr's user, the Authorize... button will be disabled and 
the Remove Authorization  button will be enabled so that you can delete the authorization. 
Otherwise, you click the Authorize... button to authorize DrawPad for uploading photos or 
videos to Flickr. 
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Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give DrawPad authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize DrawPad to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in DrawPad. 
5. Click Ready to confirm that authorization is complete. 
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.

2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.

3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.

4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.

5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.

6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.

7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.

9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.

A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.

A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.

B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.

D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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General - Information Panel
Information Panel In general, this panel gives the information of the current point where 
mouse is pointing to and basic properties of the object that is currently selected.
The following set of fields gets updated everytime the mouse moves in the canvas or if 
something was selected, resized, or moved.
Mouse Position (x, y) 
Displays the current x and y coordinates of where the mouse points using top left of the canvas 
as point (0, 0).
Selected Object Details (x, y) width x height  
Gives the selected object's current x and y coordinates in the canvas and its dimensions in 
pixels.
Mouse Position Color 
Displays the color details of the pixel where mouse is currently pointing to.
Color details includes Red, Green  and Blue values, color in Hexadecimal format (#ffffff), Hu
e , Saturation and Value.
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General - Color Picker
Color Picker The Color Picker allows you to select the colors used for drawing. In general, the 
stroke will apply to the border/outline of elements, or to elements that are simply drawn on the 
image. The fill color is used for filling elements, as well as determining background colors and 
adding stops to gradients. To change a color, simply click on the corresponding button in the 
color picker to open the Color Chooser dialog. There is a button between the stroke and fill 
that will allow you to swap the colors between the two.
Additional Options  
The Stroke and Fill buttons both have optional drop down menus that give you the options of 
removing the fill/stroke, as well as copying one from the other. The Fill button also will let you 
select a pattern to fill some elements with using the Fill Pattern Selection dialog. Both Stroke 
and Fill buttons will also allow you to create a gradient color as stroke or fill

Fill Pattern Selection dialog  
It is used to select one of the provided patterns or by loading your own image by clicking it's 
Browse button. The pattern will be applied for filling up elements created as well as text fill.
Stroke/Fill With a Gradient Option  
In this option, you can create your own gradient color using the controls available in the 
colorpicker panel's gradient section
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General - Color Chooser Dialog
Color Chooser Dialog The color picker is divided into multiple parts, with several ways 
available to choose a color.
Visually Adjusting Color  
The top half of the dialog consists of 2 colored boxes, one that lets you pick any point in a 256 
x 256 square and the other that works as a long slider. Which colors are displayed in these two 
boxes depends on which radio button is selected (see below), but in all cases the position of 
the slider will change the colors available in the square box. Which ever point is selected in 
that square box is the selected color.

Adjusting by RGB or HSV 
Underneath the square colored box, there is a series of 6 options (1 each for hue, saturation, 
value, red, green, and blue) that each contains a radio button, a slider, and an up-down 
number control. If one of the 3 HSV radio buttons is selected, that value will be represented by 
the visual slider (see above) while the other two values will be the axes of the square color 
box. The controls work the same way if one of the RGB radio buttons is selected. You can also 
adjust these values with the sliders provided next to the labels, as well as the up/down controls 
next to the sliders. Any adjustment of these values will update the visual controls, and any 
adjustment of those visual controls will update these values.

Selected Color 
The selected color is displayed to the right of the RGB and HSV controls. The box is split 
diagonally, with the upper left section labeled New (the color you are creating), and the bottom 
right section labeled Current (the color that already exists, and will continue to be selected if 
you Cancel the dialog). Beneath that is the Hex Value of the selected color (you can also enter 
any valid hex value there to update the selected color). There is an eyedropper button to the 
right of the selected color that will allow you to set the selected color by sampling anywhere on 
the desktop.

Opacity 
There is an opacity slider underneath the selected color that lets you set the transparency (the 
alpha channel value in 32 bit color) of the selected color. There is a checkered pattern drawn 
underneath the selected color so that you can see the effects of the choosen opacity.

User-defined Color Palette 
At the bottom of the dialog you will find a series of 12 colored rectangles alongside a button 
titled Set to Swatch. These comprise the user-defined color palette, and allow you create and 
save (these will persist even when DrawPad is closed) your own custom colors. To set a 
swatch's color, first select that swatch by clicking it. Then choose your desired color, and finally 
click the Set to Swatch button. You can then load any of the saved colors by simply clicking on 
that swatch.
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General - Layer List
Layer List  The Layer List appears on the lower right side of the screen, and allows you to 
view and interact with all the layers that make up the current project.
What is a Layer  
Layers are a way to subdivide the content that makes up an image, to make organization 
easier. Think of a layer as a transparent piece of canvas that you can draw on, and each layer 
is stacked on top of the others to make up the overall image. The layer that is selected in the 
Layer List is the layer that content gets added to when you draw in the image with a tool.

Manipulating Layers  
You can rename layers by clicking on the name, and typing the new name. You can also 
change the order of layers by clicking on a layer and dragging it to a different location in the 
layer list.

On the left side of each layer entry is a toggle button that will let you display a list of all the 
elements in that layer. When this list is open, you can select any of those elements by clicking 
it on the list (this is an easy way to select an element that is "hidden" beneath another, larger 
element). If you double click an element, it will select that element and any adjacent elements 
that are of the same type. Any selected elements will be highlighted in this list.

Each layer entry also has its own visibility and lock controls right beside the layer name. 
Toggling visibility will hide/show all of the layer's elements in canvas, while lock control will 
lock/unlock the layer from editing.

Layer List Controls  
Add This adds a new blank layer to the top of the layer list.
Delete  
This deletes the currently selected layer, so long as there is more than one layer in the image.
Duplicate  
This creates a copy of the currently selected layer (and all the elements in it) and adds it to the 
top of the layer list.
Merge Layer Down 
This will merge the selected layer with the layer below it in the layer list.
Layer Opacity 
A trackbar control to adjust the currently selected layer's opacity.
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General - Selected Objects
Selected Objects When an object is selected, either through the select tool or because it was 
just created, a frame will appear around that object. This frame, or widget, allows you to modify 
the shape that you just finished drawing.

All objects in DrawPad can be moved around by using the left mouse button to click and drag 
the objects around. You can also resize the objects by dragging one of the handles located on 
the corners of the widget. In both cases, the mouse cursor should change to indicate what 
action you are about to perform.

Rotation  
Several object types have widgets that will allow you to rotate the object. Drag the rotate 
handle to rotate the object (the widget will show you a rectangular frame that indicates the new 
position as you drag the handle).

Aligning Elements  
If you select multiple elements, then the Alignment options in the Select menu become 
available. You can choose to align the selected elements vertically or horizontally, and which 
side of the elements you want to align.
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General - Cut, Copy, Paste
Cut  (Ctrl + X) , Copy  (Ctrl + C), Paste (Ctrl + V) Whenever you cut or copy a selected object, 
not only is an image of that element copied to the clipboard (allowing you to paste it into any 
other application), the element itself is copied to the clipboard. This allows you to paste that 
element back into DrawPad, and then continue to modify any settings (fill colors, gradients, 
shadows, etc.) of the newly pasted element.

Copy and Paste Effects 
When you have an element selected, right clicking that element gives you the option to either 
Copy Effects, or Paste Effects. Copy Effects lets you copy all the styles/effects that apply to 
that element, including fill color, gradients, shadows, bevel/emboss, and inner/outer glow. Any 
of those attributes will be copied, and when attempting to Paste Effects all (or as many are 
applicable to the targeted element) will be applied to that element.
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General - Undo / Redo
Use Edit -> Undo (or Ctrl+Z) to undo the most recently performed action. Undo can be used 
several times in a row to undo progressively older actions. 
Use Edit -> Redo  (or Ctrl+Y) to undo an undo action. 
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General - Merge Layer Down
Merge Layer Down The Merge feature allows you to combine 2 layers (and all the elements 
in them) into a single layer. It also will preserve the order of each element, so if one element is 
"on top" of another, it will stay that way after the layers are merged. 

To merge 2 layers, they must be adjacent to each other. Select the topmost layer, and then 
select Edit -> Merge Layer Down. The 2 layers will then be combined into a single layer, 
retaining the name of the bottom layer. 
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General - Rulers
Enable Rulers Select View -> Enable Rulers to toggle the ruler display along the top and left 
sides of your images. It will use your choice of Default Units for displaying measurements.
Ruler Units 
To change the type of units displayed by the ruler, change the Default Units setting in the 
Options dialog.
Using adjustable guides 
Guides allow you to align content to specific positions on the canvas. You can adjust their 
position by simply dragging them across the ruler (rulers must be enabled to use guides). If 
Snapping is enabled in the Options dialog, then content will automatically snap to the guide 
when you drag it close by. 
Creation 
To create a guide, simply click on the ruler. The guide will appear, and you can adjust its 
position by dragging.
Removal 
To remove a guide, simply drag it past the visible edge of the canvas. If you are zoomed in too 
far to see the canvas edge, simply dragging it past the visible portion of the canvas will remove 
it.
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General - Stroke Editing
Stroke Editing  Whenever you select any of the elements created by a drawing tool (pen, 
pencil, marker, etc.), you have the option available to "Allow Line Editing". If you enable this 
option you will have the ability to edit the stroke by manipulating the points that make up the 
stroke as well as the control points that control the strength, and direction of the curve.

Points  
When you first select a stroke and enable line editing, you will see a series of small squares 
running along the line, connected by a series of lines. These are the points that make up the 
stroke. You can click and drag any of these points to reposition them. You can also right click 
on one if you wish to delete it.

Bezier Control Points  
The strokes you draw are rendered as bezier curves, which gives you the opportunity to not 
only edit the points that make up the stroke, but also the ability to control the amount and 
direction of the curve between 2 points on the stroke. Whenever you select one of the points 
on the line (one of the squares), it will be highlighted, and 2 circular points will appear 
connected to it. These are the bezier control points. Drag them around to see how they can 
control the curve.
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General - Touchpad Compatibility
Touchpad Compatibility DrawPad is capable of supporting devices that have pressure 
sensitive touchpads (digitizers). If you are using DrawPad with a PC that has a pressure 
capable touchscreen or other touch/stylus controlled input device, you can enable this feature 
through the Options dialog.
When you draw strokes with the pen tool using a touchpad that is pressure sensitive, the 
thickness of your stroke will vary according to how hard you press. Maximum pressure will 
result in a stroke 50% larger than the specified width, while minimum pressure will result in a 
stroke that is 50% smaller than the specified width.
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General - Fullscreen View
Fullscreen View Displays the current project image in fullscreen.
This option can be found at the menu bar's View > View Fullscreen option. To exit or close 
fullscreen view, just press Esc key  or click the close button  at the top right corner of the 
window.
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General - Shortcuts
Tools and Options Shortcut Keys
New Project Ctrl + N
Open File Ctrl + O
Save Project Ctrl + S
Save Project As Ctrl + Shift + S
Cut Ctrl + X
Copy Ctrl + C
Paste Ctrl + V
Undo Ctrl + Z
Redo Ctrl + Y
Zoom In Ctrl + Num+
Zoom Out Ctrl + Num-
Select All Ctrl + A
Close Project Ctrl + W
Remove Selection Ctrl + D
Show Menu Options Alt
Bevel and Emboss Alt + B
Drop Shadow Alt + V
Inner Glow Alt + N
Outer Glow Alt + M
Rectangular Selection Alt + J
Elliptical Selection Alt + K
Lasso Alt + L
Wand Alt + W
Insert Image Alt + I
Insert Clipart Alt + C
Crop Tool Alt + Q
Resize Image Alt + Z
Resize Canvas Alt + X
Align Horizontal Alt + R
Align Vertical Alt + T
Convert Element to Path Alt + O
Convert Path to another Path Alt + P
Text and Curved Text content selection Shift + Home, End or Arrow keys
Selection Tool Esc
Delete Delete
Add Element to Selection Ctrl + Left Click
Remove Element from Selection Alt + Left Click
View Fullscreen F11
Pencil P
Marker M
Crayon C
Spray R
Brush H
Pen Q
Distort Tool D
Fill Tool F
Text Tool T
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Curved Text Tool U
Eyedropper Y
Eraser E
Star S
Triangle I
Circle O
Polygon N
Rectangle A
Ellipse J
Polyline K
Line L
Bubble B
Bezier Tool Z
Increment brush/eraser size ] or }
Reduce brush/eraser size [ or {
Help page F1
Exit/Close Application Alt + F4
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Tools - Select
Select Tool The select tool allows you to select an already existing item so that you can 
perform further actions on that item.
When the select tool is selected, hovering the mouse over elements in the currently selected 
layer will show an outline of those elements. Clicking will then select that element. Once 
selected, any applicable property panels will appear, and will display the current options for 
that element. Changing any of those options will then change the selected element.

You can hold down the Ctrl key to allow you to select multiple elements from the current layer. 
Once multiple items are selected, moving will move them all as a group and resizing will also 
resize all the selected items. If you hold down the Alt key while you have multiple elements 
selected, you can remove items from that selection by clicking on them.You can also use Ctrl + 
D key to deselect or remove current selection.

The Layer List can also be used to select items.
You can also delete selected items, move them around, resize them, and copy/cut them.
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Tools - Area Selection Tools
Area Selection The area selection tools (lasso, rectangular, elliptical, and magic wand), allow 
you to create a selection of a certain area of the image (unlike the Select tool, which only 
selects specific elements). You can then use these selections to create new filled elements 
(from the context menu), or to cut/copy  the existing content.
Switching between any of these tools will maintain the current selection, though switching to 
other tools may remove the selection (see next paragraph). If a selection already exists, you 
can add to it by holding the Ctrl key while drawing another selection. You can also remove 
from an existing selection by holding the Alt key while drawing another selection.

If you switch to any of the path based drawing tools (Pencil, Pen, Marker, etc.), any selections 
you have drawn will be maintained, and will be used to limit the drawing area (only points 
inside that selection will be recorded).

Lasso Tool: Allows you to draw a free form selection.
Rectangular Selection Tool:  Draws a rectangular selection.
Elliptical Selection Tool:  Draws an elliptical selection.
Magic Wand Tool:  Selects all adjacent area of a similar color (the threshold option determines 
how closely the color must match).
Select Inverse Tool: Inverts the current selection in the canvas.
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Tools - Rectangle
Rectangle Tool  The rectangle tool allows you to draw a rectangle. Simply click and hold down 
the mouse, drag until you get the size rectangle you want, then release the mouse button.
The stroke width option allows you to specify how thick of a border you want for the rectangle, 
while the current Stroke Color will be used for the color of the rectangle's border.
Elements drawn with the Rectangle tool can be filled with either a solid color or a gradient. 
You can also apply a drop shadow to rectangle elements, as well as bevel/emboss them, or 
add a glow to it.
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Tools - Line
Line Tool  The line tool allows you to draw a straight line. Simply click and hold down the 
mouse, drag until you get the line you want, then release the mouse button.
The line width option allows you to specify how thick the line should be, while the current 
Stroke Color will be used for the color of the line.
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Tools - Poly Line
Poly Line Tool The line tool allows you to draw a freeform series of connected lines. Simply 
click each location where you wish to have a line endpoint. When you're finished, you can 
either double click at the last position, or click the Create Element button. If you make a 
mistake and wish to start over, the Remove Points button will remove all existing points. Once 
you are done, a Pen element is created and selected, and you can adjust any other options 
(such as line width, fill, etc.).
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Tools - Polygon
Polygon Tool  The Polygon tool allows you to draw a polygon. Simply click and hold down the 
mouse, drag until you get the size polygon you want, then release the mouse button.
The stroke width option the thickness of the polygon border, while the current Stroke Color will 
be used for the color of the polygon's border. The Number of Sides option lets you set how 
many sides you want the polygon to have (up to 10 sides).
Elements drawn with the Polygon tool can be filled with either a solid color or a gradient. You 
can also apply a drop shadow to polygon elements, as well as bevel/emboss them, or add a 
glow to it.
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Tools - Eyedropper
Eyedropper Tool The Eyedropper tool allows you to set the stroke color by clicking the mouse 
on an area of the desired color. Simply select the eyedropper tool, then click the mouse 
anywhere on the computer screen that has your desired color. Once you've selected your 
color, the Select tool will be selected.
You can click on other windows/applications to select a color with the eyedropper, but do 
realize that clicking the mouse on other applications may cause them to use that mouse click.
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Tools - Ellipse
Ellipse Tool The Ellipse tool allows you to draw a circle or ellipse. Simply click and hold down 
the mouse, drag until you get the size ellipse you want, then release the mouse button.
The stroke width option allows you to specify how thick of a border you want, while the current 
Stroke Color will be used for the color of the ellipse's border.
Elements drawn with the Ellipse tool can be filled with either a solid color or a gradient. You 
can also apply a drop shadow to ellipse elements, as well as bevel/emboss them, or add a 
glow to it.
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Tools - Triangle
Triangle Tool The Triangle tool allows you to draw a right triangle (as opposed to the 
isosceles triangles produced by the polygon tool). Simply click and hold down the mouse, drag 
until you get the size triangle you want, then release the mouse button. The corner where the 
mouse was released will be the location of the right angle of the triangle.

The stroke width option allows you to specify how thick of a border you want, while the current 
Stroke Color will be used for the color of the triangle's border.
Elements drawn with the triangle tool can be filled with either a solid color or a gradient. You 
can also apply a drop shadow to triangle elements, as well as bevel/emboss them, or add a 
glow to it.
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Tools - Circle
Circle Tool The Circle tool allows you to draw a perfect circle. Simply click and hold down the 
mouse, drag until you get the size circle you want, then release the mouse button.
The stroke width option allows you to specify how thick of a border you want, while the current 
Stroke Color will be used for the color of the circle's border.
Elements drawn with the Circle tool can be filled with either a solid color or a gradient. You can 
also apply a drop shadow to circle elements, as well as bevel/emboss them, or add a glow to it.
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Tools - Speech Bubble Tool
Speech Bubbles The Speech Bubble Tool allows you to create speech bubbles with several 
different callout options (the thing that points towards the speaker). The stroke width specifies 
the thickness of the bubble's border in pixels.

The Callout Position option determines which side of the bubble the callout drops down from 
(left or right). The Callout Direction option indicates which direction the callout is facing 
(regardless of its position).

When you complete drawing your Speech Bubble, it will be created as a Pen Element. This 
gives you the freedom to adjust it further if you desire (by manipulating the resulting bezier 
points, for example). It is also selected automatically so you can fine tunes its position.
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Tools - Star Tool
Star Tool The stroke width option allows you to specify how thick of a border you want, while 
the current Stroke Color will be used for the color of the star's border.
When you complete drawing your Star element, it will be created as a Pen Element. This gives 
you the freedom to adjust it further if you desire (by manipulating the resulting bezier points, for 
example). The element will not be selected after creation, so that you can continue to draw 
further Stars.
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Tools - Frame
Frame Tool  The Frame tool allows you to insert a frame image on your current project. This 
will create its own layer on top of all your current layers.
You can also change the inserted frame image using the frame panel options. To open the 
frame panel, simply select the frame image in the canvas or find it in the Layer List
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Tools - Watermark
Watermark Tool This tool allows you to add an image with the watermark effect on your 
current project. This will create a new layer for your image on top of your current layers. 
Watermark image element after being added, can be customized too.

Customize the image with the watermark options panel controls. To do this, simply select the 
watermark element by clicking it in the Layer List. Use the panel to adjust your image size, 
transparency and alignment.
Use Image Scale  control to resize your image, sizing the image is based on your current 
project dimensions, setting it to 100% will occupy the whole project size.
Transparency control lets you adjust the image opacity, use the slider to how much you want 
your image to be transparent or opaque.
Usually watermark images are positioned at the center of the page or project, but you can 
always change it using the Alignment control. This control will let you position your image to 
whichever side or corner you would want it to be.
Last but not the least, is the Manual Positioning control. This option when enabled, will let 
you directly modify the image you've added. Use the widget controls around the image to manu
ally Resize , Move or even Rotate your watermark image.
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Tools - Crop
Crop Tool  The Crop tool allows you to crop the existing image to a new size by clicking and 
dragging out a rectangle. After doing that, the crop panel displays the new image's dimensions, 
and then gives you the choice to either proceed with the crop, or cancel it and leave the image 
the way it was.

39



Tools - Text
Text Tool  The Text tool allows you to create an element that contains formatted text. When 
first selected, a text box will be automatically created for you (you can resize/move it as you 
wish). The tool also allows you to drag out a text box if you wish. To enter text, simply type the 
text in the text box. If you wish to move the text box, click and drag in the gray frame that 
surrounds the text itself.

Formatting Text 
The Font Size option allows you to specify the pixel size of the text. There are also buttons 
provided to allow for left, right, or center alignment.
Styling Text 
Some standard text options are provided, such as bold, italic and underline. Multiple formats 
are supported in one text element, you can select a portion of the text and change any option 
(except for alignment) for just that selection. Elements drawn with the text tool can have a 
drop shadow applied to them, and you can also bevel/emboss them.
Resizing Text Boxes 
There are 2 buttons at the bottom of the text control panel, titled "Resize Bounds" and "Distort 
Text"
Resize Bounds 
This will allow you to change the bounds that contains your text, without changing the 
size/shape of the text/font itself. This will affect how word wrapping occurs if your text is too big 
to fit on one line. If your total amount of text contains more lines that could fit in your resized 
bounds, the excess will simply be cropped away.

Distort Text  
This will allow you to distort/stretch the text itself. Word wrapping and line placement will not be 
affect by the resizing. Instead, the text/font itself will be stretched so that it can fit within the 
box. No cropping will occur with this option when the text is resized smaller.
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Tools - Curved Text
Curved Text Tool The Curved Text Tool allows you to draw text that follows a path on the 
screen, instead of being confined to a rectangular text box which forms paragraphs of text, like 
the regular Text Tool. You can apply multiple styles to your curved text, and you can 
manipulate the curve after creation to adjust the display of the text.
Drawing the Curve  
When you first select the Curved Text Tool, it will appear as if nothing has happened. That is 
because you must first draw a path before you can start typing your text. Draw a path for your 
text to follow, and when you are done the element will be created. At that point you may begin 
typing, or you can edit the curve if you'd like.

Editing the curve  
Editing the curve is very similar to the process used for the Bezier Tool. You can use the frame 
around the curve to move the entire curve. You can select the points along the curve (squares) 
and move them. Selecting a point will also display the bezier control points (circles) that can 
then be moved. As much text as possible will be displayed along the length of the curve, but 
any text beyond what fits will not (it won't be deleted, just not displayed).

Tip: While the text is warped to try and fit it on the curve without overlapping, this isn't always 
possible with very tight bends in the curve. Larger font sizes make the issue more likely. If you 
are encountering a situation where certain characters are overlapping, try to smooth out any 
sharp bends in the curve or reduce the font size.

Typing the Text 
After you've drawn the curve, you can start typing to add text. The cursor will be initially placed 
at the beginning of the curve and continue to the end. For example, if you draw a horizontal 
line from right to left then the text will start upside down underneath the right side of the line. If 
you want the text on top of the line, you would have to draw from left to right.

Styling the Text  
The main differences between this and the regular text tool, with regards to text styling, are the 
absence of alignment and spacing options and the addition of the ability to apply a fill and 
stroke to the text. As you type, you can change any text option (or stroke/fill colors) and 
continue typing with the new styles without changing any existing text. You can also highlight 
any existing text and then change any styles for that highlighted block.
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Tools - Eraser
Eraser Tool  The Eraser tool allows you to erase part of an image. Erasing takes place on the 
selected layer, and will erase any content that is on that current layer.
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Tools - Custom Brush
Custom Brush Tool The Custom Brush Tool allows you to create your own brush, and adjust 
all the properties used during the drawing of a brush stroke. After selecting the tool, the Edit 
Brush Style button will open the Custom Brush Editor dialog to allow you to create a new 
brush, or edit properties of the current brush.

Custom Brush Editor  
Test Surface  
On the left side of the dialog is a small surface where you can test your settings by drawing 
some sample strokes. Changing a setting will clear the surface, and the Clear Test Surface 
button will allow you to manually clear the surface.

Brush Selection 
An image selection list allows you to select from any of the saved brushes.
The Load Custom Image button will allow you to select an image to use as a stamp to create 
your own brush with. In most cases, an image with a transparent background will create the 
best results.

The Load Brush Pack button loads .arb brush pack files created for Photoshop. These are 
commonly available online. DrawPad is able to load most of these, however, some versions 
are not supported.

The Use Stroke Color checkbox will allow you to replace all the colors in the image with the 
current Stroke Color. Only transparent pixels will be unchanged.
Brush Radius 
This is the radius of the brush in pixels.
Valid values range from 1 - 250 pixels.
Roundness 
This is the ratio of width to height. A value of 100 leaves the brush as it is (perfectly round), 
while a value of zero will flatten the brush into a horizontal line.
Valid values range from 0 - 100.
Spacing  
This is distance between each step (where a stamp is drawn) of the stroke. The value is a 
percentage of the brush size. A value of 100 means that each new stamp will start after the 
previous has ended. A value of 50 would have each new stamp start in the middle of the 
previous one.

Valid values range from 1 - 100.
Rotation  
Stamp rotation in degrees.
Valid values range from 0 - 360.
Flip Vertically and Flip Horizontally  
When enabled, these checkboxes will flip the stamp image.
Count 
This is how many stamps are drawn at each step along the path. Without a partially 
transparent stamp, or Jitter Scatter, you will not notice any difference in the stroke.
Count Fade 
For values greater than 0, this will decrease the count at each step until it reaches 1. This 
value is how many steps until the count reaches 1. So if this value is 10 and the count is 10, 
the first step would have 10 stamps, the second would have 9 stamps, the third would have 8 
stamps, and so on.

Jitter Scatter 
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Randomly adjusts the position of the stamp at each step. This value is a percentage of the 
brush size, so a value of 100 would allow a stamp to be one entire diameter away from the 
normal location of the stamp.

Valid values range from 0 - 100.
Jitter Rotation 
Randomly rotates the stamp placed at each step. This value is in degrees of rotation, and the 
rotation could be either clockwise or counter-clockwise.
Valid values range from 0 - 180.
Jitter Count  
Randomly adjusts the Count at each step. This value is the maximum percentage of the Count 
that is placed at each step. So with a Count of 10, and a Jitter Count of 100, the number of 
stamps at each step will be somewhere between 1 and 10.

Valid values range from 0 - 100. A value of 0 will disable this option.
Jitter Size 
Randomly adjusts the size of the stamp at each step. This value is a percentage of the brush 
size, which is the maximum amount that the size will be increased or decreased. With a Radius 
of 50 with Jitter Size of 50, the stamp size could be anywhere from 50 - 150. With a Jitter Size 
of 100, the stamp size could be 0 - 200.

Valid values range from 0 - 100. A value of 0 will disable this option.
Scatter Horizontally/Vertically/All Directions  
Lets you decide to scatter only horizontally, only vertically, or in any direction.
Pressure Sensitivity 
If you have a pressure sensitive touchpad connected and enabled, this will allow you to select 
which option can be controlled by your drawing pressure.
Radius: Light pressure will result in a smaller radius, while higher pressure will result in a larger 
radius, up to the specified Brush Radius. 
Spacing: Light pressure will result in smaller spacing, while higher pressure will result in more 
spacing, up to the specified Spacing. 
Count: Light pressure will result in fewer stamps at each step, while higher pressure will result 
in more stamps at each step, up to the specified Count. 
Count Jitter: Light pressure will result in less count jitter (each step will be have closer to Count 
number of stamps), while higher pressure will result in more jitter, up to the specified Jitter 
Count. 

Scatter Jitter: Light pressure will result in less scattering, while higher pressure will result in 
more scattering, up to the specified Jitter Scatter. 
Size Jitter: Light pressure will result in a smaller adjustment to the size, while higher pressure 
will result in more adjustment of the size, up to the specified Jitter Size. 
Rotation Jitter: Light pressure will result in fewer degrees of random rotation, while higher 
pressure will result in more rotation, up to the specified Jitter Rotation. 

44

touchpad.html


Tools - Pencil
Pencil Tool The pencil tool allows you to draw on the screen and produce a pencil-like stroke. 
The current Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn.
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

The widget  for pencil elements also allows you to modify the shape of the stroke after you 
have completed it.
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Tools - Brush
Brush Tool  The Brush tool allows you to draw on the screen and produce brush-like stroke. 
The current Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn. The Softness 
option determines how sharp-edged the stroke will be; higher values will appear softer. The 
opacity option lets you make the brush stroke appear transparent.

The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

The widget  for brush elements also allows you to modify the shape of the stroke after you 
have completed it.
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Tools - Spray Paint
Spray Paint Tool  The spray paint tool allows you to draw on the screen and produce a 
splattered, spray can inspired stroke. The current Stroke Color will be the color of the drawn 
path. The opacity option lets you make the brush stroke appear transparent.
The Brush Size option allows you to specify how wide of a stroke is drawn.
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

The widget  for spray paint elements also allows you to modify the shape of the stroke after you 
have completed it.
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Tools - Marker
Marker Tool  The marker tool allows you to draw on the screen and produce a hard-edged, 
partially transparent stroke. The current Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn.
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

The widget  for marker elements also allows you to modify the shape of the stroke after you 
have completed it.
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Tools - Pen
Pen Tool The pen tool allows you to draw on the screen and produce one of several different 
pen strokes. The box at the bottom of the panel shows you the shape and name of each style 
of stroke that's available. The current Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn.
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

Elements drawn with the Pen tool can be filled with either a solid color or a gradient. You can 
also apply a drop shadow to pen elements, as well as bevel/emboss them.
The widget  for pen elements also allows you to modify the shape of the stroke after you have 
completed it.
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Tools - Crayon
Crayon Tool The crayon tool allows you to draw on the screen and produce a crayon stroke. 
The current Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn.
The Smoothing option allows you to control how much automatic smoothing is applied to any 
paths drawn. Maximum smoothing will remove many points in an attempt to make a very 
smooth curve (at the expense of accuracy). Minimum smoothing will leave all points in the 
path, preserving accuracy (what you draw is what you get).

The widget  for crayon elements also allows you to modify the shape of the stroke after you 
have completed it.

50

colorpicker.html
drawwidget.html


Tools - Pixel Brush
Pixel Brush Tool  The pixel brush tool allows you to draw on the screen a pixel accurate 
stroke. This is the perfect tool if you are trying to create an icon image. The current 
Stroke Color will be the color of the drawn path.
The Brush Size option allows you to specify how wide of a stroke is drawn.
You can either draw or erase an existing pixel in the canvas by toggling the Draw and Erase 
buttons found in the Pixel Brush Options panel
The widget for pixel brush elements allows you to modify the selected pixels in an existing 
stroke.
Pixel selection 
You can select drawn pixel by clicking it. You can also select multiple pixels by pressing Ctrl 
key and clicking each pixels you want to select.
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Tools - Bezier Curve
Bezier Curve The bezier tool allows you to create curves with the highest possible precision, 
by manually selecting the points, and the bezier control points that determine how "curvy" the 
path is.

After selecting this tool, simply click to create the first point of the curve. Each point you create 
will be connected to the previously place point in the order they were created. If you press and 
hold the mouse button down, the point will be placed where you first pressed the button while 
the position of the control points will be determined by the position of the cursor when you 
release the mouse button.

You can move any point that's already been placed by dragging it to a new position (the bezier 
points will maintain the same relative positioning), and after selecting a previously place point 
(click to select it) you can individually adjust the bezier points also. You may delete a point at 
any time by right clicking on it to show the context menu, or by using the Remove Points option 
in the panel to clear all points.

When you have finished creating your curve, you can create an element by selecting one of 
the drawing tools from the pulldown menu in the Bezier Tool panel (underneath the layer list). 
Click Create Element to create the new element.
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Element Options - Solid Fill
Solid Fill  The Fill option lets you fill an element with a solid color that is determined by the 
current Fill Color. It also provides you with an option to set the level of transparency of the fill.
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Element Options - Gradient
Gradient The Gradient option lets you fill an element with a gradient of your own design.
The Gradient Options panel consists of two main parts. The direction picker on the left (lets 
you choose the direction and orientation of the gradient), and the stop selector on the right (lets 
you choose what colors to use and where to put them). There is also a slider to allow you to 
set the opacity of the gradient.

Stop Selector 
This lets you choose which colors appear in your gradient. To add a color, simply click 
somewhere in the selector and another stop will be added (the color picker dialog will open for 
you to choose a color). Each stop is indicated by a small marker that appears to the right of the 
selector. You can select any stop by clicking on it, and the color picker dialog will open for you 
to change that color. You can also drag the stops around in the box to change their position. 
Clicking the Remove Marker button will remove the selected stop. 

Linear Gradient 
A linear gradient will appear in a linear fashion from one end of the element to the other. New 
gradients are linear by default. The direction picker will have a line with two ends; the start 
represented by a square, and the end represented by a triangle. Moving these around will 
control both the size and the direction of the gradient. The color of the start is indicated by the 
bottom most stop in the stop selector, while the end color is indicated by the top most stop. 

Radial Gradient 
If the Radial Gradient checkbox is selected, the gradient will appear in a circular fashion. The 
direction picker will have only a single rectangle in it, which you can click and drag to choose 
where in your selected element the center of the radial gradient will appear. In the stop 
selector, the bottom most color will be the center of the gradient, while the top most color will 
be the outer edge of the gradient. 
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Element Options - Drop Shadow
Drop Shadow The Drop Shadow option lets you add a drop shadow to the selected element. 
Once you've added the shadow, the Drop Shadow options panel will appear to allow you to 
customize the shadow.

The Edge Softness option controls how blurry the edges of the shadow will appear (higher 
values will appear blurrier). The Shadow Size option controls how big the shadow is relative to 
the element that is casting it (positive values are larger than the base element, negative values 
are smaller than the base element). The horizontal and vertical offset options allow you to 
position the shadow where you want it.
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Element Options - Bevel and Emboss
Bevel and Emboss The Bevel and Emboss option lets you add a beveled (3D like) 
appearance to the selected element. The size slider allows you to tune the size of the effect to 
your liking.

Generally, a smaller size, e.g. 2, presents more obvious beveled appearance.
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Element Options - Path Conversion
Element to Path When you have a rectangle, polygon, or triangle element selected, the 
Element to Path option becomes available. Selecting this option will convert that shape into a 
path (a pen element to be specific). You can then modify that in any way that you would 
modify a path. This option is also available by right clicking a selected shape.
Change Path Type 
When you have a drawn path selected (pen, marker, etc.), you can change it to any of the 
other path types by using the Change Path Type option on the Effects tab of the toolbar. This 
is also available by right clicking a selected path element.
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Element Options - Path Finder
Path Finder Options You can combine two vector object paths into one based on what you 
want to do using these tool options. This can be done by selecting two intersecting paths and 
clicking these toolbar option buttons.

Combine  
Adds or combines the two selected paths to form a new single path.
Subtract 
Uses the topmost path to remove the intersection area from the other path.
Intersect  
Creates a new path using the intersection area of the two paths.
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Element Options - Glows
Glows For either type of glow, you may select the color used by clicking on the Glow Color 
button. The strength slider will control how large (how far from the element's edges) the glow 
will be. 

Inner Glow  
An inner glow will create a glow that extends from the edge of the element inwards, fading as it 
gets away from the edge.
Outer Glow 
An outer glow will create a glow that extends from the edge of the element outwards, fading 
further away from the element.
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Element Options - Image Vectorization
Vectorizing an image When you insert an image, you have the option of using a vectorized 
version of that image. Because it is then represented as a collection of many paths, it will not 
lose detail as the size is increased in the same way that a rasterized image will. To enable, 
simply select the Use Vectorization of Image checkbox, and use the slider to set the detail 
level. The higher the level of detail, the more paths will be used in the resulting vectorization. 
Higher detail settings can take a very long time to calculate, especially on larger images. It is 
recommended to resize large images (> 1 megapixel) to a smaller size before vectorizing. 
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Element Options - Distort
Distort Distort allows you to move one corner of an element, independently of the other 3 
corners.
When an element (most element types are supported) is selected, the Distort option becomes 
available. Selecting it will do two things, first it will convert that element to a Pen element. 
Second, it will bring up the distortion frame which has a control point on each corner of the 
element. You can move any one of these control points and the entire element will stretch to fill 
the new bounds you create.
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Element Options - Skew
Skew Skew allows you to move one side of an element independently of the opposite side.
When a path based element (pen, pencil, etc.) is selected, the Skew option becomes available 
from the context menu. Selecting it will bring up the skew frame which has a control point on 
each side of the element. You can move any one of these control points and the entire element 
will stretch to fill the new bounds you create.
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Element Options - Perspective Distortion
Perspective Distortion  Perspective Distortion allows you to narrow or widen one side of an 
element.
When a path based element (pen, pencil, etc.) is selected, the Perspective Distortion option 
becomes available from the context menu. Selecting it will bring up the skew frame which has 
a control point on each side of the element. You can move any one of these control points and 
the entire element will stretch to fill the new bounds you create.
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Element Options - Flip
Flip Flip options allows you to flip the currently selected drawing element to create a reflection 
effect.
You can either flip an element horizontally or vertically using their designated buttons in the 
toolbar.
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Element Options - Clipart
Clipart  Add clipart images to your photos with the clipart tool. To find this tool, click the Clipart 
icon on the Advanced tab.
Use the panel on the left to select a clipart category. When a category is selected, a list of 
clipart images will be displayed in the center of the dialog. Click on any image in the list to see 
a preview on the right side of the dialog.

When you find a clipart image you like, click the Download button. Once the image has finished 
loading, the clipart image will be added to the project as an Image element on the selected 
layer on the Layer List.
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Element Options - Group/Ungroup
Group/Ungroup  Group or Ungroup currently selected elements.
To use this option, select multiple elements in the canvas using the select tool. Then right click 
on the selection and choose Group or Ungroup option.
This option will allow you to edit multiple elements at once. When an element is grouped, it will 
always be selected with other group members, use Ungroup option to remove elements from 
grouping or edit them separately.

Editing Separately 
Grouped elements can be edited separately without ungrouping.
Right click on the currently selected group of elements and then choose Edit option. This 
option will let you choose from the list of elements under this group
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Dialogs - New Image
Creating a New Image 
Name Type your project name here.
Units 
This is what type of unit you wish to use when defining the size of the new image in this dialog.
Width and Height 
Specify the width and height in your chosen units here.
Pixels Per Unit 
Specify the resolution, how many pixels will fit in your chosen unit, of your new image here.
Background 
Here you can specify whether you want the image to have a transparent background, or a 
background of the current Fill Color as the background. You can change the fill color now if 
you would like a different color than the current one. 
Background Transparency  
If you have selected to use a background color, this will let you adjust its transparency level.
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Dialogs - New Banner Ad
Creating a New Banner Ad Project
Name 
Type your banner project name here.
Sizes 
Select from the list of preset project dimensions. The list also includes where each dimensions 
best fit (i.e Facebook Post, Twitter Cover, etc.)
Background Fill Type Options

Colored and Transparent Background 
Choose a color from the colorpicker  or choose a transparent background.
Background Gradient  
Use the gradient section controls to create your own gradient as the project background.
Background Pattern 
Choose from the pattern image list or browse your computer for an image to be used as 
pattern image, just click on the browse button below the image list.
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Dialogs - Contract/Expand Selection
Contract Selection This dialog will allow you to make an existing selection smaller by 
contracting the bounds. You provide the number of pixels you wish to contract the selection by.
Expand Selection 
This dialog will allow you to make an existing selection larger by expanding the bounds. You 
provide the number of pixels you wish to expand the selection by.
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Dialogs - Options
Default Units This is the default unit that you would like DrawPad to use for measuring length.
Guide Options
Enable Snapping to Other Elements  
When moving an element, it will automatically snap to other element's edge or middle point. 
Use the distance field to set how close the moving element is to other to snap
Enable Rotation Snapping 
When rotating an object, it will automatically snap to 90, 180, 270, and 360 degree 
orientations. This option determines how close you must be to one of those values before the 
element will snap.

Show Grid Lines  
This option allows you to display grid lines across the canvas at a set interval.
Grid Line Increment 
This is the interval (in default units) between the grid lines.
Enable Snapping to Grid Lines 
Snapping will allow you to quickly and precisely place elements by automatically aligning the 
edges with the grid lines, or any ruler guides you may have placed.
Movement/Resizing Snapping Distance 
This is how far away an element can be from a guide or grid line before it snaps to it.
Show Pixel Grid Lines  
This option allows you to display grid lines across the canvas at pixel size interval. Can only be 
enabled when project was zoomed to minimum of 800%
Touchpad Options
Use Touchpad devices 
If you have any touchpad devices attached to this computer, enable this option to use them 
with DrawPad.
Collect input from all touchpad devices 
If you want to draw from any and all input devices (mouse, touchpad, etc.), enable this option. 
If this option is disabled, DrawPad will only collect input from the Current Touchpad Device.
Current Touchpad Device 
If you only want to collect input from one touchpad device, then select it from this drop-down 
list. If the device you select is pressure sensitive, you will see the message "This touchpad is 
pressure sensitive" displayed underneath the drop-down list.
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Dialogs - Send Email
Sending an Email This dialog allows you to send an email with your current image (in the 
format of your choice) as an attachment.
To 
Write the recipient's email address or addresses here.
Subject  
This is the email's subject line.
Message 
Write the body of the email here. The email will be sent in plain text, so no formatting is 
possible.
Image Format  
Choose from .jpg, .png, .bmp and .svg of the image format that you would like to use for the 
attachment.
Email Settings 
This opens the Email Settings dialog that lets you choose the proper settings for sending 
emails with DrawPad.
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Dialogs - Resizing
Image Resizing There are 2 ways to resize the image: Resize Image (which will scale all the 
content accordingly), or Resize Canvas (which will only adjust the canvas size without scaling 
any content). Both of these options are in the Edit menu, and both open up similar dialogs.

The following fields are the same regardless of which method you use.
Units 
Select the units you would like to use for specifying the width and height.
Width 
The new width of the image in your selected units.
Height  
The new height of the image in your selected units.
Keep Aspect Ratio  
If this is selected, your changes to one dimension will change the other so that the overall 
width to height ratio of the image is preserved.
Reset Button  
If clicked, values set in Height and Width field will be reset to the current Image/Canvas 
dimensions.
The options specific to each method are listed below.
Resize Image  Pixels per Unit
The number of pixels used to represent one of your selected units (not applicable when units 
are pixels).
Resize Canvas Anchor Point
Since resizing the canvas does not scale the elements, you can choose the anchor point that 
determines where the elements should be positioned in the newly resized canvas. There are 
buttons corresponding to 9 page positions (indicated by arrows). For example, if you make 
both dimensions larger and select the middle anchor point (the default), then the canvas will 
expand equally on all sides of the existing content. If you choose top left, then the canvas will 
expand to below and to the right of the existing content (everything was "anchored" to the top 
left of the canvas).
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Dialogs - Template Wizard
Template Wizard The template wizard offers a quick way to create one of several types of 
projects. When it opens, you will be presented with a list of project types that you may choose 
from. After making your selection, select the Next button.

The next page lets you select which template style you would like to create. Select one of the 
options from the list, and select the Next button.
The next page is the text replacement page. You will be presented with a graphic of the project 
that has any text fields highlighted in a dashed box. You may select a box by clicking in it. To 
fill in the text you may either type in the edit field provided, or use the browse control to load a 
document. Once you have completed all the text fields, select the Next button.

The final page is the image replacement page (some templates may not need this page, and it 
will be skipped). You can select images similarly to the text replacement page, and then load 
an image by using the browse control below. After you are done, select the Finish button and 
your project will be created.
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Image Settings - ICO Encoding Settings
Preset  

Select one of the preset configurations to automatically enable the image formats 
recommended for the chosen scenario.
Formats 
The ICO file will contain an image in each of the enabled image formats. Higher resolutions 
and more bits-per-pixels (bpp) give higher quality images, but increase the file size. 
Note: ICO files containing a PNG encoded image cannot be read by File Explorer prior to 
Windows Vista. 
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Image Settings - JPEG Compression Settings
Quality 

Choose between a smaller file with lower quality, or a larger file with higher quality. 
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Image Settings - BMP Encoding Settings
Pixel Format 

Choose between a file with 8, 24 or 32 bits per pixel. You must select 32 bits per pixel if you 
wish to have any transparency in the picture. 
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Image Settings - PNG Encoding Settings
256 color 

You can check this option to 256-color palette PNG which is smaller than true color PNG. 
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Image Settings - PNM Encoding Settings
Portable Anymap Format 

Choose either monochrome (portable pixmap), grayscale (portable graymap) or RGB 
(portable bitmap) format. Each of them can be saved as plain (ASCII) or binary files. 
Binary threshold 
Set the threshold for converting image to binary image. It is only used with monochrome 
formats. 
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Image Settings - TIFF Encoding Settings
256 color 

You can check this option to 256-color palette TIFF which is smaller than true color TIFF. 
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Image Settings - PDF Encoding Settings
Paper Size 

Select the paper size you would like to use for the target PDF document.
Orientation 
Select the paper orientation you would like to use for the target PDF document.
Margin 
Input the margin value in millimeter as top, left, bottom and right margin.
Scaling Mode 
Select the mode to decide how to scale images in PDF page.
● None: keep the original size of the image. If images do not have resolution description, 

the default value (e.g. 72DPI) will be used.
● Fit to Printable Area: reduce or enlarge each image to the paper size except the 

margins and keep the same aspect ratio in width and height.
● Stretch to Printable Area: stretch the image to be full of the entire page except the 

margins.
● Auto Fit by Image Size: scale the image to a reasonable size
Positioning Mode 
Select the positioning mode to decide how to place images in PDF page.
Image quality 
Select the image quality when embed it into a PDF file. The higher the value, the better the 
embedded image quality is.
Auto Rotation  
Adjusts the image’s orientation to match the selected paper size and orientation.
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Image Settings - WebP Compression Settings
WebP is a new image format developed by Google and supported in Chrome, Opera and 
Android that is optimized to enable faster and smaller images on the Web. WebP images are 
about 30% smaller in size compared to PNG and JPEG images at equivalent visual quality. 

Lossy Compression 
Saves a smaller file than lossless compression, but causes some reduction in image quality. 
Quality 

Choose between a smaller file with lower quality, or a larger file with higher quality. 
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Image Settings - GIF Encoding Settings
Multi-page GIF (animated GIF) 

You can tick this option to create an animated GIF file. You can specify the delay of each 
frame by checking in the "Set frame delay in seconds" input box and putting a time delay.
Multiple GIF Files  
You can tick this option to create separate GIF files for each frame.
Check "Prompt when converting multi-page images"  if you want the GIF encoding settings 

to pop-up when converting multi-page images.
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Screen References - Color Picker Dialog
Color Picker Dialog  
The color picker is divided into multiple parts, with several ways available to choose a color: 
Visually Adjusting Color  

The top half of the dialog consists of 2 colored boxes, one that lets you pick any point in a 
256 x 256 square and the other that works as a long slider. Which colors are displayed in 
these two boxes depends on which radio button is selected (see below), but in all cases the 
position of the slider will change the colors available in the square box. Which ever point is 
selected in that square box is the selected color. 

Adjusting by RGB or HSV 
Underneath the square colored box, there is a series of 6 options (1 each for hue, 
saturation, value, red, green, and blue) that each contains a radio button, a slider, and an 
up-down number control. If one of the 3 HSV radio buttons is selected, that value will be 
represented by the visual slider (see above) while the other two values will be the axes of 
the square color box. The controls work the same way if one of the RGB radio buttons is 
selected. You can also adjust these values with the sliders provided next to the labels, as 
well as the up/down controls next to the sliders. Any adjustment of these values will update 
the visual controls, and any adjustment of those visual controls will update these values. 

Selected Color 
The selected color is displayed to the right of the RGB and HSV controls. The box is split 
diagonally, with the upper left section labeled New (the color you are creating), and the 
bottom right section labeled Current (the color that already exists, and will continue to be 
selected if you Cancel the dialog). Beneath that is the Hex Value of the selected color (you 
can also enter any valid hex value there to update the selected color). There is an 
eyedropper button to the right of the selected color that will allow you to set the selected 
color by sampling anywhere on the desktop. 

User-defined Color Palette  
At the bottom of the dialog you will find a series of 12 colored rectangles alongside a button 
titled Set to Swatch. These comprise the user-defined color palette, and allow you create 
and save (these will persist even when DrawPad is closed) your own custom colors. To set 
a swatch's color, first select that swatch by clicking it. Then choose your desired color, and 
finally click the Set to Swatch button. You can then load any of the saved colors by simply 
clicking on that swatch. 
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